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New Features in Allplan 
2008 
Requirements for installing and running 
Allplan 2008 

Before you begin, please check that all the computers where you 
want to install Allplan 2008 meet the minimum requirements. 
 

Hardware requirements 

The following table lists the minimum requirements for running 
Allplan 2008: 

Minimum setup 

• Intel® Pentium® III or compatible 

• Processor with a rate of at least 1GHz  

• 512 MB RAM 

• 1 GB free hard disk space 

• Graphics board, resolution 1280 x 1024 

• Floppy disk drive, connection to network or email for installing 
the license 
  

Note: Up-to-date information on hardware can be found on the 
Nemetschek website (http://www.nemetschek.de/info/sys2006). 
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Software requirements 

Allplan 2008 runs on the following operating systems: 

• Recommendation: Windows XP Professional, Service Pack 2 

• Windows XP Home, Service Pack 2 

• Windows Vista 

• Windows 2000, Service Pack 4 

• Windows Server 2003, Service Pack 1 

• In addition to the operating systems mentioned above, file servers 
run on the following operating systems: 

- Novell NetWare 6.5 with NetWare Services (Allplan 2008 is 
the last version to support Novell) 

- Suse Linux 9.1 with Samba server 3.0 based on Reiser file 
system 

Please check the entire network: all workstations must be equipped 
with one of the operating systems mentioned above. 

Notes: 
Allplan runs on Apple hardware in conjunction with Intel 
processor and Windows operating system. Up-to-date 
information is provided on this website. 
(http://www.nemetschek.de/info/mac2006) 

Installations using other operating systems than the ones stated 
above are not tested (for example, other Linux versions, HP-UX 
or MacIntosh). Please note that Allplan 2008 does not run on 
these operating systems. We do not provide any support for these 
types of installations. 
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Interoperability 

Importing 2D PDF Data 

A new option has been integrated into Allplan allowing all users to 
import 2D PDF data to documents: 

• Import on the File menu 

• Import in the Plot Layout module 

Detailed information on importing PDF files is provided in the online 
Help. 
 

Exporting 2D PDF Data 

There are different options for saving Allplan data as PDF files: 

• Export on the File menu 
Detailed information on exporting PDF files is provided in the 
online Help. 

•  Print Preview in drawing file edit mode  
Detailed information on the print preview is provided in the 
online Help. 

Navigation and usage have also been improved: 

• Files can be appended to existing files 

• Allplan layers can be transferred as PDF planes 

• Printing can be locked 

• Detailed information on the Export PDF File dialog box is 
provided in the online Help. 
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Exporting 3D PDF Data 

You can save Allplan models as 3D PDF files straight from the 
Allplan animation window. Allplan uses the same procedure as 
Adobe does.  

Acrobat Reader 7 and higher lets you display the data in 3D.  

PDF files can also be edited in Adobe Reader (measuring, redlining 
or setting sections).  

This tool optimizes connmunication with clients. 

Detailed information is provided in the online Help.  
 
  
 

DWG/DXF/DGN Interface 

• DWG, DXF and DGN files can be inserted as XRefs (using Insert - 
Custom XRef). 

• RGB fills can be created during import 

• Color=pen option (in AutoCAD specific tab) 

• Correction factor for layout unit (in AutoCAD specific tab) 

• Exporting/importing pixel areas: 

- DWG + referenced bitmap is created when pixel areas are 
exported 

- When DWG + bitmaps are imported, bitmaps are not imported 
as bitmaps but as pixel areas 

 

Archiving layouts using DocuWare 

The special interface to DocuWare is no longer available in Allplan 
2008. Now you need to use Tiffmaker to archive documents in 
DocuWare archives. 

As a result, the DocuWare-specific settings in the  Plot Layouts 
and  Archiving tools, in ProjectPilot and in the export options 
are no longer available. 
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Print plotfiles and archives 

You need to use Nemetschek drivers to output plotfiles and archives 
using the  Print Plotfiles and Archives tool. If you have not 
defined an output channel in the Services application, the program 
will issue an appropriate message when you select this tool. 
 

Import CINEMA 4D XML Data 

CINEMA 4D release 10.5 and higher includes a new option you need 
to enable in order to import C4D XML files to Allplan: 
Program defaults - Document - Save polygons for melange 
exchange 

Note: In CINEMA R9.5 you can still import XML files by dragging 
and dropping. 
 

Ease of Use 

Free-Floating or Docked Pallets with Flyouts 

The most important new feature of Allplan's graphical user interface 
is the new pallets, which are always available: 

• Properties pallet 

• Tools pallet 

• Modules pallet 

• Wizards pallet 

Detailed information is provided in the online Help. 

Configuration pallets 
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Wizards 

• Wizards can be grouped 

• Several Wizards can be displayed in a pallet. You can specify 
how tabs are arranged using Customize on the shortcut menu. 

• Wizards can be saved as *.nas files using Save Copy As. 

• Wizards can be saved as *.nas files with resources using Save 
Copy As. 

 

Drawing Types, Linestyles, Area Styles 

• Area styles, linestyles and drawing types can be arranged in 
groups. 

• The NONE drawing type can be selected in the status bar. 

• New default drawing types are available for engineering. 
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Folders for Saving Files 

You can use Save in in the Global Options, Settings tab, to specify 
any folders where Allplan data is to be saved as usual in most MS 
Office programs. These folders are automatically selected in the Save 
dialog box appropriate to the file type you want to save. Of course, 
you can change these folders at any time. 

You can specify folders for the following file types (File type 
column): 

• Custom NDW/NPL files 

• Symbol files 

• Import/export 

• IFC 

• PDF export 

• 3D representation 

• Bitmaps, movies 

• Pixel files 

• Plotfiles 

• Smart symbol files 

You can set the following folders in the Path column: 

• Project (for the current project) 

• Private (for the private project of the user) 

• Custom (any path can be selected) 

• Last (the last path selected) 

The default setting is displayed in the Folder column. 
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Selection Preview and Element Info 

Selection preview 

Information on position and extents of elements is always at hand. 
All you need to do is point to an element and a preview of the 
element appears as if you selected it.  

Element info 

The element type and properties are displayed attached to the 
crosshairs when you move the mouse to an element - that's all you 
need to uniquely indentify elements!  

You can display the following elements: 

• Element name  

• Pen, line, color, layer  

• Sequence, group 
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Thi makes things easier and helps you avoid errors without 
additional efforts. 
 

Hiding Construction Lines using Show/Hide 

All the elements displayed in the construction line color can be 
hidden centrally using  Show/Hide. 

This way, you can quickly and easily display the screen contents 
without construction lines, which is useful for checking the layout or 
print preview or making screenshots. 
 

Show/hide center of circles 

Centers of circles and ellipses can be shown and hidden using  
Show/Hide. 

By default, the centers of circles are not displayed.  
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Shortcut Menus for Selecting Elements and Entering Points Work in the 
Same Way 

When modifying components, you can quickly and easily show all 
functions available for element selection as you would when 
entering points. All you need to do is press CTRL and click in the 
workspace with the right mouse button. 

 

You no longer need the Filter Assistant toolbar. You can switch it 
off to free up space on screen. 
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Filter Step by Step, Hatching Number, Pattern Number 

Stretch Entities Displays the Points Selected 

All the points you select in the  Stretch Entities tool are marked 
by symbols both in 2D and 3D. These symbols are similar to handles. 

This provides a safe and intuitive way of modifying elements as you 
can see which points are affected right from the start. 

      

 
 

New Tool for Replacing Layout Elements 

Batch Plot with Windows Drivers 

New Dialog Box for Assigning Colors and Pens when Plotting 

Retain plot settings 

In previous versions, the output device or paper format was 
automatically reset to its default if this setting, which was saved 
together with the relevant layout, was not available when you 
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opened this layout using Windows drivers.  Allplan 2008 includes 
the following improvements: 

• The program does not check the availability of the output device 
and paper format saved in the layout until you activate the  
Plot Layouts tool. This way, the process of switching to the 
layout editor has been accelerated considerably even when the 
output device or paper format saved in the layout is not 
available. 

• If the output device saved in the layout is not available, the 
program displays a dialog box where you can specify which 
device you want to use. 

• If the paper format saved in the layout is not available, the 
program attempts to find an identical format with a different 
name. 
If this attempt fails, the program selects the next larger paper 
format. If the resulting larger printable area is within a specific 
tolerance range, which you can define as a percentage in the Plot 
Layout module's options, the program will use this paper format 
without prompting you. Otherwise, you can specify which format 
you want to use in a dialog box.  

Note: When the program uses a new paper format without 
prompting you, the original format is still saved together with the 
layout and used for plotting if it is available again. 
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Plot/Close instead of prompt 

The prompt Would you like to start plotting? has been replaced by 
the following two buttons: Plot and Close. Now you can proceed as 
you would in any other Windows application: 

• Clicking Plot saves the settings and starts the plot operation. This 
is equivalent to clicking OK and choosing Yes at the prompt. 

• Clicking Close saves the settings, However, the plot operation 
does not start. This is equivalent to clicking OK and choosing No 
at the prompt. 

 

New Catalogs Are Immediately Visible to All Users 

Making workgroup use easier:  
New catalogs are immediately visible to all users. 

 
 



 

14 Ease of Use Allplan 2008 
 

Measuring Tools Can Be Activated Separately 

The 

 Measure Length 

 Measure Coordinates 

 Measure Angle 

 Measure Volume 

 Measure Area 

are available as separate tools. 

You can use Tools - Customize - Additional tools with icon to 
integrate these tools in a toolbar or to assign a shortcut key. The  
Measure Length and  Measure Coordinates tools are included in 
the Standard toolbar with certain default configurations (e.g. Tools 
pallet configuration).  
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Draft, Layout, Design 

Advanced Dialog Boxes for Lines, Polylines and Circles 

Advanced dialog boxes are available for lines, polylines, circles and 
other 2D design entities.  

Now you can 

• specify the type and size of a start symbol 

• specify the type and size of an end symbol 

• undo your actions step by step 

• and lots more! 

For eaxmple, a line becomes an "arrow" and a polyline changes to a 
"chain" - new options open up for layout design (e.g. flow charts). 
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Leaders with symbols at start and end 

The same options are provided for leaders as for lines: you can apply 
symbols (e.g. arrows) to the start and end of leaders. There are also 
two new options for discrete lines and polylines. 
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RGB Background Colors 

The entire RGB color palette including more than 16 million colors is 
available for hatching styles, patterns, and pattern lines. 

You can  

• match colors from existing elements or bitmaps using the 
"magnifier" 

• use all Allplan color systems 

 

This allows you to enhance layouts as you can select any 
background color for hatching styles and patterns.  
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Aligning and Arranging Elements 

Two new Allplan tools, which work in the same way as the tools for 
text and elements in lists/schedules, provide additional support as 
you align and arrange design entities. 

 Align provides the following options: 

• Left-aligned, right-aligned or aligned with the top or bottom  

• Vertically-aligned, horizontally-aligned, centered 

 

Detailed information on aligning is provided in the online Help. 

 Arrange provides the following options: 

• Horizontal with four options 

• Vertical with four options 

 

Detailed information on arranging is provided in the online Help. 

All design entities can be aligned and arranged; you can even apply 
these two functions to different elements.  

This makes layout design in Allplan even easier! 
 

Trim Option Available for Intersect 2 Entities 

The  Intersect 2 Entities tool allows you to trim the second 
element at the same time.  

Click Trimming in the Input options. 
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Allplan presents a preview of all suitable trim options; all you need 
to do is click the option you want to use.  

Detailed information on intersecting two entities is provided in the 
online Help. 

 

This way, you can intersect two entities and trim the second element 
in a single step, which speeds up the 2D design process. 
 

Resizing with Reference Length 

The  Resize tool lets you take the reference length directly from 
another component.  

You enter the resizing factor by clicking in the workspace or by 
entering two lines - the reference length and the new length - as 
numerical values. The program calculates the resizing factor based 
on the ratio of new length to reference length. All dimensions of the 
selected elements are multiplied by this factor. 

 

This function helps you accomplish your tasks more quickly and also 
assists users who previously worked with AutoCAD or ADT. 

Detailed information on resizing is provided in the online Help. 
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New Tool for Deleting Duplicates 

The new  Delete Duplicates tools detects duplicate elements and 
deletes one element. 

If you inadvertently copied two identical data records to a document, 
you can quickly and easily eliminate the duplicate data record. 

Detailed information on deleting duplicates is provided in the online 
Help. 
 

Four-Point Tent 

You can use  Three-Point Tent, Four-Point Tent to create any 
area between three or four points. The parameters specifying how 
these elements are to be dvided in the longitudinal and transverse 
directions are user-definable. You can also make settings for 
deformations.  

 

This tool lets you create any area and solid in an easy and 
comfortable manner.  

Detailed information on three-point tents and four-point tents is 
provided in the online Help. 
 



 

New Features in Allplan 2008 New Features in Allplan 2008 21 
 

Symbol Catalogs 

Planned for V2008: 

• Improved 2D symbols; new, current look & feel 

• Groups allowing you to place furniture more quickly 

• Trees, persons (freehand) created by a designer 

• Current cars (BMW, Audi, VW and Mercedes Benz) in 2D, all 
views and 3D 

• New textures, photos of trees and persons 

 
 

Bitmap function on Insert menu no longer required 

Bitmaps can be placed quickly and easily in documents (drawing 
files and custom NDWs) using the  Bitmap Area tool, which is 
included in the Draft module and Insert menu, for example.  

Therefore, the Bitmap tool on the Insert menu is no longer required.  

For more information please consult the chapters Bitmap area and 
How to insert bitmaps in the online Help. 
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New display options for crosshairs 

To ensure optimum usage, Allplan provides new options for 
displaying the crosshairs. 

• You can disable the crosshairs to improve performance with 
terminal servers.  

• The mouse cursor can be displayed in addition. This can be useful 
if the crosshairs are not clearly visible due to gray fills, for 
example. 
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Working with the building structure 

Basics 

What is the building structure? 

The building structure is an additional option to apply a logical 
structure to a building. For example, it makes data exchange via IFC 
easier.  

Sections, views and lists can be derived directly from a building 
structure. 
 

Advantages of the building structure 

Views, sections and lists can be generated quickly. 

Source drawing files and target drawing files are saved; you do not 
need to give any thought to which drawing files should be activated. 
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Creating the project structure 

The following three levels are provided: 

• Structure 

• Building 

• Floor level 

Notes: 

• You can drag and drop levels into the Project Structure area on 
the left. 

• When you drag a new level into the Project Structure area, it is 
attached below the level where the cursor is positioned when you 
release the mouse button. 

• When the hierarchical level has been placed, you can assign it a 
name or accept the one proposed by the system. 

• You can also change the name later. To do this, click the level 
and type a name. 

• To delete levels from the hierarchy, drag them out of the Project 
Structure area and release the mouse button. You cannot delete a 
level without deleting any subordinate levels it may have. 

• Levels in the hierarchy may only be used in their hierarchical 
sequence. For example, you cannot place a building structure 
below a floor level. To generate a correct file IFC-compliant file, 
you should always use the Building structural level – even when 
you want to export a floor level only. This is the only way to 
ensure that the data is assigned correctly in the destination 
system. 
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Modifying building structures 

Quickly creating a building structure using the plane 
manager 

Behavior of building structure in workgroup environment 

Each user can modify the building structure. If several users modify 
the building structure at the same time, an icon is displayed. You can 
save your own changes as a conflict document. 

  

The plane manager can only be opened by one user at any one time. 
If another user has already opened the plane manager, a ToolTip 
with the user's name is displayed. 

The building structure is saved as a XML-format file in the project 
folder. If several users are modifying the building structure at the 
same time, the changes are saved as conflict documents (*.conflict). 

    

Without workgroup 

 

With workgroup 
 

Building structure - fileset structure 

You can use the building structure and the fileset structure in 
parallel manner. The drawing file status can be set in the fileset 
structure and in the building structure; these two settings are 
independent of each other. The drawing files are activated depending 
on which of the two tabs is active when you close the dialog box. 

Important difference: a drawing file can only be assigned once in the 
building structure. 
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Brainstorming 

A building structure can consist of five predefined structural levels 
as well as any structural levels that can be placed freely in the tree 
structure.  

The building structure is saved as a XML-format file in the project 
folder. 

The drawing files can be placed at any level (e.g. the drawing file 
with the plot is assigned directly to the site; the drawing file with the 
chimney (which is not limited to a single story) is assigned directly 
to the building). 

Important: as opposed to filesets, a drawing file can only be placed 
in the tree structure once. 

 

Five predefined structural levels are provided: 

• Site 

• Structure 

• Building 

• Story 

• Sub-story 

Predefined means that  

A superordinate node cannot be below a subordinate node (for 
example, a structure must be superordinate to a building and a 
building must be superordinate to a story). However, nodes can be 
left out (for example, a building can be subordinate to a project; 
even a story can be can be subordinate to a project).  

Predefined structural levels can also be named freely. The program 
still knows which levels are concerned.  

 

In addition, any structural levels can be used. 

These custom levels can be placed freely in the tree structure, i.e. 
between (superordinate/subordinate to) predefined nodes. You can 
also assign drawing files and user-defined names to these custom 
structural levels.   
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Please note that custom levels cannot be placed at the same 
hierarchical level as predefined nodes as this would lead to problems 
during import/export. 

 

 

 

 

 
 

Tips 

Selecting structural levels 

Clicking a check box activates the relevant node and all subordinate 
nodes. 

Clicking a check box while pressing the CTRL key only activates this 
node. Subordinate nodes are not activated. 
 

Dialog boxes 

'Open on a project-specific basis: files and filesets' dialog 
box, building structure tab 

You can create and modify a building structure in the Open on a 
project-specific basis: files and filesets dialog box , Building 
structure tab. To access this dialog box, click  on the Standard 
toolbar. 

Building structure (left pane in dialog box) 

In the tree view, the current building structure is displayed with 
structural levels and assigned drawing files. You can sort the view so 
that entries are displayed in ascending or descending order by 
clicking the column head. In this view, you can make drawing files 
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current and open them in edit or reference mode. For more 
information, see Drawing file status. 

 Expand selected entries 
Expands the view so that all subentries of the selected node are 
displayed. 

 Collapse selected entries 
Collapses the view so that only the superordinate nodes are displayed 

 Update 
Updates the display of the filesets and drawing files or of the 
building structure (for example, after the building structure has been 
modified by another user). 

 Plane manager 
Opens the plane manager. 

 Insert predefined structural levels 
Opens a window from which you can drag and drop predefined 
structural levels into the building structure. Click this icon again to 
close the window. 

 Insert any structural levels 
Opens a window from which you can drag and drop any structural 
levels into the building structure. Click this icon again to close the 
window. 

 Assign drawing files 
Opens a window from which you can drag and drop drawing files 
into the building structure. This way, you can assign drawing files to 
structural levels. Drawing files that have already been assigned to a 
structural level are marked with ???. You can also see which drawing 
files are in use as they are marked with ???. 

 Import data again 
Imports the drawing file status you saved last in the 
Structure_Settings.xml  default file using  Save. 

 Save 
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Saves the current drawing file status of the building structure in the 
Structure_Settings.xml default file. 

/  Mark locked drawing files, filesets on/off 
Specifies whether locked drawing files and filesets (i.e. drawing files 
and filesets opened by another user) are marked with a symbol or 
not. The name of the user is displayed when you click Properties on 
the shortcut menu. This option is only available when workgroup is 
installed. 

 Options 
You can use this tool to make basic settings for the Open on a 
project-specific basis: files and filesets dialog box. For example, 
you can specify the size of the icons. For more information, see 
Options. 
 

'Select file' dialog box 

You can select drawing files in this dialog box. You can use the 
buttons at top left to define how the drawing files are displayed in 
this dialog box: they can be arranged by building structure, object 
derived from the building structure (views, sections) and by drawing 
file/fileset. 

 Drawing file/fileset 
Sorts and displays the drawing files by fileset. In addition, all 
available drawing files are displayed under All drawing files. 

 Derived from building structure 
Sorts and displays the drawing files by object derived from the 
building structure (e.g. sections). 

 Building structure 
Sorts and displays the drawing files by building structure. 

The selection of drawing files can be saved as a favorite. When you 
select a superordinate node, all subordinate drawing files are 
automatically included. 
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'Restrictions of building structure' dialog box 

You can use this dialog box to specify which structural levels and 
drawing file assignments can be used in the building structure. 

Permissible structural levels 
Select the structural levels that can be used in the building structure.  

Permissible drawing file assignments 
Select the structural levels that can be assigned drawing files. 

IFC-compliant structure 
Clicking this button only selects the structural levels and drawing 
file assignments that are in compliance with IFC. 

Any Allplan structure 
Clicking this button selects all structural levels and drawing file 
assignments. 
 

'Layer setting, layer set' dialog box 

You can use this dialog box to specify which layers of the source 
drawing files are to be included. 

Elements from source drawing files 

Use current layer setting 
Includes the layers as currently defined. 

Include all layers 
Includes all layers, regardless of the current layer setting. 

Use layer set 
Includes the layers as defined by the current layer set. This setting 
requires a layer set. If there is no layer set, this setting is not 
available. 
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'Behavior of drawing files' dialog box 

You can use this dialog box to specify how elements that are 
independent of default reference planes behave when default planes 
are assigned. 

Transfer information from planes to all drawing files of the structural 
level 
This option is available when you assign planes to a structural level. 
When this option is active, the selected height is assigned to the 
default planes of all drawing files subordinate to the structural level. 
When this option is not active, the selected height is only assigned to 
the structural level; the height of the default planes in the drawing 
files does not change. 

Also move elements whose height is fixed (absolute elevation, stairs) 
in z direction 

Also move plane model-independent planes and roof planes in z 
direction 

Move by delta Z 

'Select list and settings' dialog box 

Select list 

You can use this to specify whether you want to create a general 
quantities schedule or a floor space schedule. Then click the button 
with the list to select a list for output. 

Output 

You can use this to specify how the list is to be output: 

• To Screen / printer 

• To File / transfer to  (click the button with the name of the 
file to specify a destination path and name for the file). 

• As a file for any program to be activated subsequently (click 
the button below to specify a program) 
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'Create / extend building structure' dialog box 

You can use this dialog box to create and modify building structures.  

Assign drawing files 
When you activate this check box, drawing files are assigned to the 
individual structural levels. When this box is not checked, only the 
building structure is created. Drawing files are not assigned.  

First drawing file 
Specify the drawing file number at which the structure is to start. 

Increment 
Specify the number of drawing files that are created per structural 
level.  

Structural level 
The structural levels that are created are displayed. 

Name 
You can enter a name for the structural level. 

From file / To file 
You can specify the first and last drawing file number of the 
structural level.  

Add views 
When you activate this check box, views are automatically assigned 
to the building structure. 

Add sections 
When you activate this check box, sections are automatically 
assigned to the building structure. 

First drawing file 
Specify the drawing file number at which the assignment of views 
and/or sections is to start. 

Increment 
Specify the number of drawing files that are created per structural 
level. 
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'Insert pair of planes' dialog box 

How to ... 

Create building structure 

Creating a building structure using the Wizard 

Creating a building structure manually 

To create a building structure  

1 Click the structural level behind which you want to insert a new 
structural level with the right mouse button, and on the shortcut 
menu, point to Insert structural level and click the desired level. 
The shortcut menu only presents structural levels that can be 
inserted at the position you specified.  

 

Modify building structure 

Move drawing files to a different structural level 

• Use drag and drop or Cut and Add below on the shortcut menu. 

Move structural level (level stays the same) 

• Use ALT+drag and drop or Cut and Add behind on the shortcut 
menu. 

Insert new structural level 

• Use the shortcut menu of a structural level (only structural 
levels that can be inserted at the position you specified are 
presented). 

• On the menu: opens a window. You can drag and drop 
structural levels from this window into the building structure. 
Structural levels that cannot be used due to restrictions are 
crossed out with a red line. 
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Extend building structure 

Strukturstufe kopieren 

To copy a structural level 

1 Click Copy on the shortcut menu of the structural level you want 
to copy and then click Add behind on the shortcut menu of the 
structural level behind which you want to insert the copy. 

Or: 

Press and hold down the CTRL+ALT keys while dragging and 
dropping the structural level you want to copy onto the structural 
level behind which you want to insert the copy. 

2 You can specify the drawing file number at which the program is 
to start inserting the copied drawing files into the new structural 
level or click Insert structural level without drawing files if you 
want to copy the structural level without drawing files. 

 



 

New Features in Allplan 2008 New Features in Allplan 2008 35 
 

Assign drawing files to structural level 

There are two ways to assign drawing files to a structural level: 

•  Assign drawing files on the menu bar. 
You can select drawing files in the Assign drawing files dialog 
box and drag and drop the selected files into the tree view. 
Drawing files that have already been assigned are marked with 

; drawing files that are in use are marked with . Clicking 
Show selected drawing files on the shortcut menu displays the 
drawing files currently selected. 

• Assign drawing files... on the shortcut menu of the structural 
level. 
You can enter drawing file numbers as follows: 

• Enter the numbers of individual drawing files separated by 
blank spaces, e.g. 10 2 19. 

• Enter a range of drawing files separated by hyphens, e.g. 
10-19. 

You can also combine these two options (e.g. 10 12 14-19 21). 

 
 

Assign planes to structural level/drawing files 

You can assign planes to a structural level and to individual drawing 
files. The height of the planes is displayed in the dialog box; 
however, the height of the planes assigned to the individual drawing 
files is only displayed when it differs from the height assigned to the 
superordinate structural level. 
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Save drawing file status 

You can save the current drawing file status in the building structure 
as a favorite. The status set for the building structure and that 
defined for objects derived from the building structure is saved 
separately on a user-specific basis in one xml-format file in the 
BIM\user\settings folder. 

On the menu bar: 

 Save on the menu bar: saves the current drawing file status of 
the building structure in the Structure_Settings.xml default 
file. 

 Save on the menu bar: saves the current drawing file status of 
the objects derived from the building structure in the 
View_Settings.xml default file. 

 Save on the shortcut menu of the project: saves the current 
drawing file status in any file. 

 Load favorite on the shortcut menu of the project: loads the 
current drawing file status from any file. 
 

Create lists in a building structure 

To create a list in a building structure 

1 Click  Lists with the right mouse button, point to Insert 
structural level on the shortcut menu and click  List. 

2 Select the source drawing files for the list. Click  List with the 
right mouse button, point to Source drawing files for list on the 
shortcut menu and select the desired drawing files in the Select 
file (See "'Select file' dialog box" on page 29) dialog box. 

3 Specify which layers are to be taken into account for list 
generation. Click  List with the right mouse button, point to 
Layer setting, layer set on the shortcut menu and select the 
desired setting in the Layer setting, layer set (See "'Layer setting, 
layer set' dialog box" on page 30) dialog box. 

4 Select a list. Click  List with the right mouse button, point to 
Select list and settings on the shortcut menu and select a list in 
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the Select list (See "'Select list and settings' dialog box" on page 
31) dialog box. 

5 Create the list by clicking  List with the right mouse button 
and selecting Create list on the shortcut menu. 

 

Create lists in a building structure 

To create a view in a building structure 

1 Click  Views with the right mouse button, point to Insert 
structural level on the shortcut menu and click  View. 

2 Select the drawing files where the views are to be saved. Click 
 View with the right mouse button, point to Assign drawing 

files on the shortcut menu and enter the numbers of the drawing 
files. You can only select drawing files that are not used in the 
building structure. 

3 Select the source drawing files for the view. Click the drawing file 
where the view is to be created with the right mouse button, 
point to Source drawing files for view on the shortcut menu and 
select the desired drawing files in the Select file (See "'Select file' 
dialog box" on page 29) dialog box. 

4 Specify which layers are to be taken into account for view 
generation. Click the drawing file where the view is to be created 
with the right mouse button, point to Layer setting, layer set on 
the shortcut menu and select the desired setting in the Layer 
setting, layer set (See "'Layer setting, layer set' dialog box" on 
page 30) dialog box. 

5 Make settings for the view. Click the drawing file where the view 
is to be created with the right mouse button, point to View 
settings on the shortcut menu and make settings  in the Settings 
for hidden line images dialog box. 

6 Create the view by clicking the drawing file where the view is to 
be created with the right mouse button, pointing to Generate 
view on the shortcut menu and selecting a view. 
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Select drawing files 

If you want to select several structural levels, for example, click to 
the right of the first structural level and open a selection rectangle. 
Only structural levels of the same hierarchical level are selected. 

You can select drawing files by clicking the drawing file number or 
name. You can also press and hold down the left mouse button and 
open a selection rectangle. 

• To select a single drawing file, click it. 

• To select a series of non-adjacent drawing files, press and 
hold down the CTRL key and click the drawing files. 

• To select a range of drawing files within the same structural 
level, click the first drawing file in the range, then press the 
SHIFT key and click the last drawing file in the range at the 
same time. Only drawing files of the same structural level are 
selected. 

• To select a range of drawing files from several structural 
levels, click to the right of the first drawing file and open a 
selection rectangle without releasing the mouse button. 

 



 

New Features in Allplan 2008 New Features in Allplan 2008 39 
 

Change drawing file status (in building structure) 

With the drawing file status, you define the drawing file on which 
you draw and which drawing files are visible and/or can be 
modified. For more information, see Drawing file status. 

To change the drawing file status 

1 Click  Open on a project-specific basis (How). 

Tip: You can also double click with the left mouse button in the 
workspace. 

2 Select the Building structure tab. 

3 Select (see "Select drawing files" on page 38) the drawing files (in 
tree view) whose status you want to change. 

4 Define the drawing file status in one of the following ways: 

• Click the selection with the right mouse button and select the 
drawing file status on the shortcut menu. 

• Click one of the three columns. 

• Make use of the space bar. Every time you press the space bar 
down, the selected drawing files are given a selection status: 
Off – open in reference mode – open in edit mode – active 
(the drawing file you select last becomes active, the other ones 
are opened in edit mode). If a drawing file cannot be open in 
reference mode (if the drawing file in question is empty and 
does not have a name), this status is skipped. 
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Architecture 

Building Information Model BIM 

Introduction 

Components 

Advantages 

 

Component-oriented building model 

• New building structure 

• New plane manager 

• New Wizard for models  

• Views, sections, lists/schedules can be derived 

• Simplified definition of smart symbols 

• Multi catalog selection for integrated solutions 

• Railing design (handrails, railing, parapets, fences etc.)  

 

From 2D design to component-oriented building models 

• Opening design using 2D smart symbols 

• Dynamic lists/schedules for rooms and groups of rooms 
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Plane Manager and Model Wizard 

• You can use the Plane Manager to create building structures. 
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• The Model Wizard creates the necessary pairs of planes. 

 

• In addition, default planes for roofscapes are possible. 

 

Allplan provides all the tools you need to set up projects for 
component-oriented design using planes, stories, structures and 
drawing files. You do not need in-depth knowledge; a few clicks are 
sufficient.  
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New Building Structure 

• Setting up a project structure quickly and easily 

• Structure is created by plane manager 

• Predefined and custom structures can be added 

• In compliance with IFC and Allfa Views 

• Parts of models can be combined as desired 

• Drawing files can be assigned as desired 

Building structure is used for organizing drawing files 
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Structuring data based on the topological structure of a building 
reflects the approach of designers.  

 
 

Building structure and drawing files/filesets 

Concurrent use 

• of the drawing file/fileset structure 

• of the new building structure 

• within a product and project  
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The concurrent use of drawing files/filesets as well as plane manager 
and building structure facilitates a smooth transition from 2D and 
3D to component-oriented building models (with or without 
Design2Cost). 

 
 

Objects Derived from Building Models 

• Views 

• Sections 

• Lists/schedules 

These objects derived from building models are created 
semi-automatically. 

 
You do not have to go through the time-consuming process of 
generating these objects manually. 
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Create new building structure, approach 

Creating and saving a new building structure involves the 
following steps: 

• Getting ready: basic settings 
Define reference scale and units (See "Basic settings" on page 46) 
(these settings are also used for the building structure) 

• Define structural levels for building structure (See "Define 
structural levels" on page 48)  

• Associate the individual stories with the default reference planes 
using the plane manager (See "Plane manager: stories and 
heights" on page 51) 

• Name drawing files (on page 59) 
 

Basic settings 

Before you create the building structure, make settings for the 
reference scale and unit of length. 

Start by setting the reference scale to 1:100. 

To set the reference scale 

1 On the View menu, click  Reference Scale. 
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Tip: Alternatively, you can set the scale in the status bar: click to 
the right of scale and select 1:100. 

2 Click 100.00 in the Scale dialog box. 
 

 

Set the unit you want to use to enter values. The values are to be 
interpreted in meters.  

To set units 

1 Click  Options (Standard toolbar) and select Global Options 
in the dialog box.  

 

Tip: Alternatively, you can set the unit in the status bar: click to 
the right of length and select m. 

2 Select the Entry tab and click m in the Units of length list box. 
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3 Click OK to confirm the settings. 
 

 
 

Define structural levels 

You should define the structural levels of the building structure so 
that they are suitable for the building you want to design. It is often 
a good idea to use stories and layer sets for organizing projects.  

First create a building structure in the project by defining different 
structural levels.  

In this example, we will use the structural levels Building and Story.  

To define structural levels 

1 Click Open on a project-specific basis. 

2 Select the Building structure tab. 
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3 Click "project name" with the right mouse button and select 
Insert structural level on the shortcut menu. 
Five predefined structural levels are provided for creating a 
building structure: 

• Site 

• Structure 

• Building 

• Story 

• Sub-story 

In addition, you can insert custom structural levels. 

 



 

50 Architecture Allplan 2008 
 

4 To define structural levels, do the following: 

• Use the shortcut menu to select the structural levels you want 
to use one after the other. 

or 

• Choose Restrictions of building structure on the shortcut 
menu. 
Uncheck the boxes for Site, Structure, Sub-story and Any 
structural level. 

 

As a result, the building structure in this example will only 
consist of the structural levels Building and Story. 
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Plane manager: stories and heights 

Height settings are to be assigned to the individual stories using the 
plane manager.  

To use the plane manager to assign height settings to 
the planes  

1 Click Plane Manager in the Open on a project-specific basis: 
files and filesets dialog box. 

2 The Plane Manager dialog box appears. Click New model. 
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3 In the New model dialog box, make settings for the number of 
stories and for the heights of the stories, slabs, floor slab and 
foundations. 

This example shows the settings for a detached house: 
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Don’t forget to check the Create / extend building structure box. 

4 Click OK to confirm the New model dialog box. 

The Create / extend building structure dialog box opens. 
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5 Make the following settings in the Create / extend building 
structure dialog box: 

• Select the desired structural levels. 

• Enter a value for Increment in the area at the top.  
This defines the number of drawing files per structural level. 

• Enter names in the Name column. 

• Enable Add views and enter the number of drawing files to be 
used for views. 

• Select the First drawing file for the views.  

• Enable Add sections and enter the number of drawing files to 
be used for sections. 

• Enter a value for Increment. 
This defines the number of drawing files per section/view. 

In this example, the Create / extend building structure dialog 
box might look like this: 
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6 You can change the numbering of drawing files in the From file 
column; subsequent numbers change accordingly. 

7 Click OK to confirm the Create / extend building structure 
dialog box. 

The Plane Manager dialog box appears. 

8 Select the entry at the top in the Plane Manager dialog box (left 
pane) and click Expand selected entries to display all entries. 

9 Now you can use the shortcut menu to delete entries that are not 
required.  
The height settings of the other planes can be retained or 
adjusted. In the latter case, you can specify whether they are to 
be moved up or down.  
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The Plane Manager dialog box might look like this:  
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10 If necessary, you can also adapt the bottom level. Click Bottom 
level of structure with the right mouse button, select Modify on 
the shortcut menu and enter the desired value.  
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11 Click OK to confirm your entries in the Plane Manager dialog 
box. 

12 You are back in the Open on a project-specific basis: files and 
filesets dialog box.  
The result might look like this: 

 

13 To select a drawing file for your work, activate the check box of 
the desired hierarchical level and then make the desired drawing 
file current.  

14 Click Close to quit the dialog box. 
 

 
 



 

New Features in Allplan 2008 New Features in Allplan 2008 59 
 

Name drawing files 

When you create a building structure, the last step is to name the 
drawing files.  

To name drawing files 

1 Click Open on a project-specific basis. 

2 Select the Building structure tab. 

3 Select the relevant drawing file number.  

4 Click the drawing file number with the right mouse button.  

The number is highlighted blue and the shortcut menu opens. 

5 Click Rename. 

 

6 Enter a name for the drawing file. 

7 Select a drawing file by activating the check box of the 
superordinate hierarchical level. Then make the desired drawing 
file current. 

 

8 Click Close to quit the dialog box. 
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More New Features in Architecture 

Defining Smart Symbols 

New dialog box for defining smart symbols 

Stucture of dialog box 

• Similar to pallets in Basic and Engineering 

• Attributes can be sorted 

• Graphical display of different foils per scale 

• Depending on height settings 

• Snoop functionality 

• Depending on drawing types 

• Changing  display parameters 
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Smart symbols can be created and maintained more easily 

 

• Smart symbols no longer need to be saved in catalogs: 

- Separate smart symbol files in *.nmk format  

- Smart symbols can be placed directly in documents and saved 
there. 

 

Show/hide junctions permanently 

Junction lines such as wall lines, sill lines or room lines you had 
removed using  Show/Hide Junctions were visible again when 
you updated architectural elements using Restore 3D View. 
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Allplan 2008 includes the following improvements: junction lines 
are only displayed or hidden again when you click them again;  
Restore 3D View has no effect.  

Note: junction lines you have already hidden or shown are displayed 
as dashed lines in selection color when you activate  Show/Hide 
Junctions. 

 

Detailed information on the Show/Hide Junctions and Delete 
Doubled Line tools is provided in the online Help. 
 

Tip: Elements are always 
hidden in their entirety. 
Overlapping lines (in the case 
of adjacent rooms, for 
example) can be deleted 
using  Delete Doubled 
Line. 
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Textures for Smart Fit Operations 

When defining elements in the Smart Fit module, you can assign 
attributes like producers and prices as well as apply surface elements.  

 

Layouts can be enhanced using fills, bitmaps and textures. 
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VOB Regulations, Part C 

New VOB rules, part C (German building regulations) 

Calculations have been adapted to meet the requirements imposed by 
the new regulations 

Concurrent managment of regulations 

• Old regulations 

• New regulations 

You can still use the old regulations to calculate existing projects 

Allplan quantities and Nemetschek D2C fulfill the requirements 
imposed by the new regulations. 
 

Door Swing with DIN Labels 

The door swing is analyzed by a label style: 

• DIN L 

• DIN R 

 

As long as users do not intervene, the display and label of doors are 
synchronized . This helps you avoid errors. 
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Attributes for Walls 

Attributes for walls in their entirety 

Walls consisting of multiple construction layers: 

• Attributes for total wall 

• Attributes per layer 

Optimum basis for analyzing physical properties, which can be 
different for each layer 

Preparation for EuroCode and IFC standard  

 

Allplan BIM can be used as a data basis for HVAC, building 
simulations and energy certificate calculations in an interdisciplinary 
manner 
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Eccentric Foundations 

Strip foundation  

• Centered 

• Eccentric 

• Cross-sectional area 

 

Any strip foundation can be displayed in a realistic manner. 

Very useful for creating component-oriented building models 
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Multiple Catalogs 

Allplan provides five different catalogs for specifying quality and 
two attribute groups for each component: 

• Material 

• Code text 

• Name 

• Physical properties 

• Method of production 

• Static system (load-bearing, non-bearing) 

• IFC attributes 
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These advanced, interdisciplinary options for analyzing architectural 
components and smart symbols are very useful when it comes to 
BIM.  
 

Dynamic Lists in Drawing Files 

• Allplan provides various lists such as    

- Window list with overview 

- Walls with legends 

- Floor area calculations with totals 

- … 

• Custom design 

• Legends can be created and maintained quickly and easily 

• Ideal complement to roomstamps 

• Graphics, labels 
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Analyses are derived directly from BIM (model space) and updated 
dynamically in paper space.  
 

Groups of stories 

... 
 

2D Opening Design 
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Railing Designer 

The new Railing Designer tool provides a convenient way of 
creating, editing and analyzing 

• Railing 

• Fences 

• Parapets and  

• Other linear components that are subdivided evenly  
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Advanced Quantity Takeoff Operations 

• Vertical surfaces of dormers 

• Vertical surfaces of beams 

• Formwork areas of beams 

• …. 
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Planes displayed in isometric view and animation 

Planes in elevation and isometric view 

Default planes, custom planes and roof planes can be displayed in 
isometric and elevation viewports. You can make the relevant 
settings in the Plane options (provided in the  Architecture 
Options, for example). 
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When this option is enabled, default planes are initially displayed as 
a square of 2mx2m at the origin. This applies for all views.  
After you have executed  Restore 3D View, the display is 
adjusted to the size of the current 3D model.  

Detailed information is provided in the online Help; see the section 
entitled Architecture options, display and creation of roof planes and 
default planes. 

Planes in elevation and isometric view 

You can use the Animation Settings to specify whether roof planes 
and default planes are displayed in animation windows.  The 
animation surface used is defined in the Plane options. 
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Detailed information is provided in the online Help; see the section 
entitled Animation settings, parameters. 

The result might look like this: 
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SpaceNavigator Facilitates Navigation in 3D and 
Animation 

3DConnexion's SpaceNavigator considerably facilitates the process 
of navigating virtual 3D space in Allplan.  

 

 

SpaceNavigator provides six axes for navigation. 
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SpaceNavigator for navigation in animation windows, details 

In addition to or instead of the mouse, you can use the 
SpaceNavigator provided by 3DConnexion for navigating in 
isometric viewports and animation windows. You can use the CTRL 
key to switch between camera mode and sphere mode as usual. 

The standard configuration of SpaceNavigator provides the following 
navigation alternatives:  
 

 
Navigation 

 
... In camera mode 

In sphere mode  
(CTRL pressed) 

 
Move to the right/ left Move to the right/ left 

 

Pan up/ down Pan up/ down 

 
Zoom in/ zoom out Zoom in/ zoom out 

 

Tilt Turn camera about object on 
the surface of an imaginary 
sphere (pan up/ down) 

 

 
Rotate 

Turn camera about object on 
the surface of an imaginary 
sphere 

 

Scroll Scroll 

Use the left key to display the object in its entirety. Use the right key 
to open the 3DConnexion Control Panel dialog box where you can 
make further settings (e.g. speed, key assignment etc.) and activate 
the online Help.  
 



 

New Features in Allplan 2008 New Features in Allplan 2008 77 
 

Room Program Wizard available to all users 

 The Room Program Wizard lets you enter and display given 
room programs in Allplan.  

 The Room Program Wizard is now available to all Allplan users.  
It is included in the Create toolbar/palette in the Quantity Takeoff: 
Rooms, Surfaces, Stories module. 

Detailed information is provided in the online Help; see the section 
entitled Introduction to Room Program Wizard (See Introduction to 
Room Program Wizard - mk:@MSITStore:rpa.chm::/31572.htm). 
 

Improved quantity takeoff operations 

You can use the  Intersect Timber, Steel Elements with Archit. 
Components tool to make timber and steel elements (e.g. rafters or 
beams) intersect existing architectural components (e.g. roof 
covering).  

In Allplan 2008 the intersecting elements are included in quantity 
takeoff operations, 

    

 
 

Engineering 

Diameter symbol and text modifications 

When the Change Text Settings tool is used to change the font of 
engineering text from Allplan to TrueType or vice versa, the 
diameter symbol also changes so that it can be used with the 
relevant font type (from ASCII 30 (Allplan) to U+00F8 (TTF) and 
vice versa). 
 



 

78 More new features Allplan 2008 
 

Thermal insulation lists 

The Arial font is used for all thermal insulation lists. Furthermore, 
we have renamed the lists for better orientation and given a uniform 
look-and-feel to the lists. 
 

More new features 

General New Features 

File and project management  

• Documents must not exceed 256 MB. 

• The advanced document access mode is active by default (when 
installing for the first time). 

• Any folder can be selected as the project folder (requirements: 
workgroup, UNC paths, folder name = project name) 

• Project attributes are sorted alphabetically.  

• Construction lines can be switched on and off in Show/Hide. 

• New tools: Close All + Save All 

• Handles can be used in conjunction with the Stretch Entities tool; 
they are transparent. 

• Print Preview Options: Fills are no longer affected by the Use 
color 1 for elements in reference drawing files setting. 
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Independent Resources 

Independent resources are available for 

• Linestyles 

• Area styles 

• Drawing types 

• Surfaces/textures 

• User-defined attributes 

• Layouts 

• Contents of the Clipboard 

• Contents of Wizards 
 

Layers 

• Quick access is available for layer sets and privilege sets using 
the following tools 

-  Modify Layer Status 

-  Select Privilege Set 

-  Select Layer Set 

• Layer sets and privilege sets can be arranged in groups. 

• Objects that are invisible (because of the priviliege set) can be 
ignored in layouts (administrator option in the Privilege set tab). 

• When creating new layers, you can specify the status in privilege 
sets / layer sets and the layer number. You can assign any 
numbers between 32768 and 65535 to layers.  

 

Project Selection 

• Enhanced dialog box 

• Projects can be copied and deleted. 

• New project filter 
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Drawing File Selection 

CTRL+click on icon restores the position to the default setting (e.g. in 
two-screen mode). 
 

Display List 

You can set properties for the display list in a dialog box. 

Use display list 

This is where you enable or disable the display list. 

Optimized display 

When this option is enabled, the display of elements is optimized. 
When it is disabled, priority is attached to performance. Please note 
that this setting only applies when the display list is active. 

Display OLE elements, advanced fills, bitmap areas 
When these options are active, the relevant elements are also 
displayed when the display list is enabled. When these options are 
disabled, only the boundary lines are displayed, which accelerates 
display on screen. 

Show TrueType in bold 
When this option is activated, TrueType fonts are displayed in bold 
so that they are clearly legible. When this option is deactivated, 
TrueType fonts are displayed normally. As a result, they may only be 
read with difficulty (depends on the font used). 

More options 

Associative Views 
When this option is enabled, associative views are mananged in the 
display lists (data is vectorized). When this option is disabled, 
associative views are not mananged in the display list. 
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XRef 

• In the case of advanced XRefs, the default planes can be taken 
from the source or target. In the case of custom planes the source 
is always used. 

• You can snap points in normal XRefs as well as in advanced 
XRefs. 

• XRefs can be trimmed as you need. 

• All advanced XRefs can be converted to normal XRefs in a single 
operation (using the shortcut menu). 

• DWG, DXF and DGN files can be inserted as XRefs (using Insert - 
Custom XRef). 
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Selection options 

Selection preview 

No tool is active (handles) 
Use this to specify whether the selection preview is to be displayed 
when no tool is active (e.g. Delete). 

A tool is active 
Use this to specify whether the selection preview is to be displayed 
when a tool is active (e.g. Delete). 

Element info 

No tool is active (handles) 
Use this to specify whether element information is to be displayed 
when no tool is active (e.g. Delete). 

A tool is active 
Use this to specify whether element information is to be displayed 
when a tool is active (e.g. Delete). 

Time limit for display in milliseconds 
Use this to specify the time which elapses until element information 
is displayed at the cursor. 

Element info 
Use this to specify what kind of element information is displayed in 
the ToolTips that are attached to the cursor. CTRL+A selects all the 
options; CTRL+SHIFT+A unselects all the options. When ToolTips 
appear, you can display all the information on the relevant element 
by pressing the TAB key (regardless of the setting you make here). 
Please note that this does not work with architectural elements). 

Function of right mouse button 

Use this to specify how the right mouse button is used when a tool is 
active. 

Bracket feature 
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The right mouse button activates the brackets feature. The shortcut 
menu for selecting elements can be opened using CTRL+right mouse 
button. 

Selection shortcut menu 
The right mouse button activates the shortcut menu for selecting 
elements. 
 

  

•   

•   

•   

•   

•   
 

Pen for TrueType fonts 

The setting you make in the Text module's options, Text height 
defines pen thickness, applies to Allplan fonts only. TrueType fonts 
are always displayed with pen 1. When the Color stands for pen 
option is enabled in Show/Hide (How), TrueType fonts are always 
displayed in the color associated with pen 1. 
 

Improved two-screen support 

Improvements for using Allplan in conjunction with two screens: 

• All dialog boxes remember their most recent positions. 

• Arrangement of viewports is retained. 
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Allplan profiles for certified graphics boards 

Allplan profiles are provided for certain graphics boards certified by 
Nemetschek for Allplan: 

• Profiles can be selected quickly and easily in the driver. 

• Better performance (e.g. for animation) 

• The latest certified graphics boards are available at: 
FAQs for graphics boards 
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Crash Reporter 

Available in Allplan 2008 Beta 3 and higher: 

As we are always trying to improve the overall quality of our 
programs, we have integrated the Crash Reporter. This new program 
automatically starts when a certain problem arises in Allplan or 
Project Pilot and documents the status of the program at the time the 
problem occurs.  The resulting error report can then be emailed to 
Nemetschek. 

  

You can describe the problem in detail in the data entry field. 

You can use click here to display and check the contents of the error 
report generated automatically and the files attached:  
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Clicking Send error report compresses the relevant files, and the 
standard email program installed on your computer starts.  

Please support us and send the error report to us.  
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Requirements for installing 
and running Allplan 2008 

Before you begin, please check that all the computers where you 
want to install Allplan 2008 meet the minimum requirements. 
 

Hardware requirements 
The following table lists the minimum requirements for running 
Allplan 2008: 

Minimum setup 

• Intel® Pentium® III or compatible 

• Processor with a rate of at least 1GHz  

• 512 MB RAM 

• 1 GB free hard disk space 

• Graphics board, resolution 1280 x 1024 

• Floppy disk drive, connection to network or email for installing 
the license 
  

Note: Up-to-date information on hardware can be found on the 
Nemetschek website (http://www.nemetschek.de/info/sys2006). 
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Software requirements 
Allplan 2008 runs on the following operating systems: 

• Recommendation: Windows XP Professional, Service Pack 2 

• Windows XP Home, Service Pack 2 

• Windows Vista 

• Windows 2000, Service Pack 4 

• Windows Server 2003, Service Pack 1 

• In addition to the operating systems mentioned above, file servers 
run on the following operating systems: 

- Novell NetWare 6.5 with NetWare Services (Allplan 2008 is 
the last version to support Novell) 

- Suse Linux 9.1 with Samba server 3.0 based on Reiser file 
system 

Please check the entire network: all workstations must be equipped 
with one of the operating systems mentioned above. 

Notes: 
Allplan runs on Apple hardware in conjunction with Intel 
processor and Windows operating system. Up-to-date 
information is provided on this website. 
(http://www.nemetschek.de/info/mac2006) 

Installations using other operating systems than the ones stated 
above are not tested (for example, other Linux versions, HP-UX 
or MacIntosh). Please note that Allplan 2008 does not run on 
these operating systems. We do not provide any support for these 
types of installations. 
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Further requirements 
The following notes are particularly interesting when you have 
installed a new operating system (e.g. Windows Vista). 

• The operating system must already be installed and running. 

• The hardware and software requirements mentioned are also valid 
for computers which serve as file servers for Allplan 2008. 

• All peripheral devices must be connected and correctly 
configured. 

• When you install two or more Allplan 2008 workstations in a 
network, it is essential that these workstations are networked 
correctly. 

- When upgrading in a network, you need to install Allplan 
2008 on all the networked workstations before you can 
resume your work. 
Please note the following: 

- Allplan 2008 can only be installed when a valid ServicePlus 
agreement and/or license file is available for the workstation 
in question. 

- You cannot use this version together with earlier Allplan 
versions or data thereof!  

• Every user must have full access to the Allplan 2008 folders; read 
access is not sufficient. 
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Notes on installing under Windows XP 
When Windows XP is installed in a default manner, the safety 
settings (access and read permission) are assigned on a restrictive 
basis. This means that only the user groups Owner, Administrator 
and System have full access rights to new folders; the User or Main 
user groups are granted read access only. In order to run Allplan 
2008, however, you require full access rights to new folders; read 
access is not sufficient. Consequently, it can happen that Allplan 
2008 does not start. 

To share the Allplan installation folder 

1 Log on as administrator. 

2 Determine the paths to the Allplan installation folders using the 
Services -> Service -> Hotline Tools -> Showcfg -> OK. 

3 Make a note of the following paths and share them as described 
in steps 4 and 5. 

• Local program folder: DATPATH = ... 

• Central file storage folder: SRVPATH = ... 

4 As administrator, share the Allplan 2008 installation folders for 
the relevant user or user group. 
To do this, select the Allplan 2008 installation folders ín 
Windows Explorer and click File -> Properties -> Security. 

5 In the Group or user names area, add the relevant user or user 
group. 
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